
An Introduction to 
Microsoft Office 2003
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M icrosoft Office 2003 is a software suite, or
collection of programs. Purchasing a software
suite is less expensive than buying each

program individually. Office 2003 suites contain different
combinations of programs; some of the programs in this
book may not be available in your suite.

Microsoft Office 2003 is available at computer and
electronic superstores. The program comes on a set of
CD-ROM disks, so you need a CD-ROM drive to install
Office 2003.

If you already have a version of Office, but want to
upgrade, you can do so. The new version contains a
revamped interface, making the programs simpler to use.

Some new computers come with Microsoft Office 2003 as part
of the computer package. If you work in a large company,
some or all of the programs may already be on your computer.

All Office 2003 programs share a common look and work in
a similar way. After you learn one program, you can easily
learn the others. Part I covers features and aspects common
to all Office 2003 programs.
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Create Documents in Word
Microsoft Word is a word processing program that
lets you create documents such as letters, reports,
manuals, and newsletters. You can edit text,
rearrange paragraphs, and check for spelling errors.
Word also has many formatting features to change
the appearance of a document. For example, you can
apply various fonts, align text, and add page
numbers. You can also enhance a document by
adding a graphic or creating a table. You can learn
more about Word in Part II.

Create Spreadsheets in Excel
Excel is a spreadsheet program you can use to
organize, analyze, and attractively present financial
data, such as a budget or sales report. Excel allows
you to enter and edit data efficiently in a worksheet.
You can enhance the appearance of a worksheet by
formatting numbers, changing the color of cells, and
adding graphics. You can use formulas and functions
to calculate and analyze the data. You can learn more
about Excel in Part III.
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Create Presentations in PowerPoint
PowerPoint is a program that helps you plan,
organize, and design professional presentations. You
can use the features in PowerPoint to edit and
organize text in a
presentation.
PowerPoint also
allows you to add
objects to the
slides including
shapes, pictures,
charts, and
tables. You can
use your
computer screen,
the Web, 35mm
slides, or overhead transparencies to deliver a
presentation. To learn more about PowerPoint, see
Part IV.

Create Databases in Access
Access is a database program that allows you to
store and manage large collections of information.
You can use a
database to store
your personal
information such
as addresses,
music collections,
and recipes.
Companies often
use a database to
store information
such as client
orders, expenses,
inventory, and payroll. An Access database consists
of several components that provide different ways to
work with the data; these include tables, forms,
queries, and reports. You can learn about Access in
Part V.

Manage Information in Outlook
Outlook is a program that helps you manage your
e-mail messages, appointments, contacts, tasks, and
notes. You can send, receive, print, save, and handle
e-mail messages as well as attach and send files to
other recipients. In addition to e-mail, Outlook
includes a
Calendar for
keeping track 
of your
appointments,
Contacts for
storing
information
about the 
people you
communicate
with, Tasks for
keeping a to-do list, and Notes to create on-screen
reminders, similar to paper sticky notes. Learn more
about Outlook in Part VI.

Create Web Pages in FrontPage
FrontPage is a program that helps you create,
manage, and maintain your own collection of Web
pages, called a Web site. Your Web pages may
contain text, pictures, tables, and hyperlinks.
FrontPage also has many formatting features you can
use to enhance your Web site. When you finish
creating the pages for your Web site, you can use
FrontPage to publish the site. You can learn more
about creating Web pages using FrontPage in Part VII.

Create Graphical Documents with Publisher
Publisher is a desktop publishing program that
designs and creates newsletters, birthday or holiday
cards, or anything that requires a pleasing
combination of text and art. If you have more
complex layout needs, Publisher is a better program
than Word for building professional-looking
documents. Publisher is covered in more detail in
Part VIII.
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Start and Exit 
a Program
O ffice allows you to start a program in several

ways. You can either start a program using the
Start menu or using a shortcut icon. What

happens upon starting a program depends on which
program you select.

In Word, Excel, FrontPage, and PowerPoint, a blank
document displays so that you can start creating a
document, workbook, or presentation.

In Access and Publisher, you see a blank area and the task
pane. You can select whether to create a new blank

database or Web, open an existing database or Web, or
create or open an existing Publisher document.

Although this section illustrates how to start a Word
document, you can use the steps to start any Office
application. For more information on getting started with
Word, Excel, PowerPoint, Access, FrontPage, or Publisher,
see Chapters 3, 9, 15, 19, 28, and 30, respectively.

When you finish working in the program, you must save
your documents and then exit the program. Doing so frees
up system resources.

4
1

2

3

All Programs

Microsoft Office

Microsoft Office Word 2003

Start a Program from the Start Menu

1 Click Start.

2 Click All Programs.

3 Click Microsoft Office.

4 Click the program you want to start.

6

Start and Exit a Program

66

The program window appears, displaying a
blank document.

Note: In Access and Publisher, you see a blank
screen. See the section “Create a New
Document” in Chapter 2 to fill the screen.
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Start a Program from a Shortcut Icon 

1 Double-click the shortcut icon.

The program starts and you see a new
blank document on-screen.
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I do not see my programs listed
on the All Programs menu. Why
not?

If the All Programs menu does
not list your programs, you may
not yet have installed Office, or
you may have only a few of the
Office programs installed instead
of the full suite. See the
appendix for help on installing
Microsoft Office.

How do I delete a shortcut
icon?

To delete a shortcut icon, 
right-click the icon, select
Delete, and then confirm the
deletion by clicking Yes.
Deleting a shortcut does not
delete the program.

How do I create a shortcut icon?

The easiest way to create a
shortcut icon is to drag the
program name from the Start
menu to the desktop. Click Start
and then click All Programs. You
see a list of all of the Office
programs. Click and drag the
desired program from the menu
to the desktop, and Windows
automatically creates a shortcut.
The program still appears on the
All Programs list.

Exit a Program

Note: Before you exit a program, save any
open documents. See Chapter 2 for
more information.

1 Click File.

2 Click Exit.

• You can also click the Close button
( ) for the program window.
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Work with 
Windows
E ach program you start or item you open appears in a

window on your desktop. Because you can have
many windows open on your screen at once, you

need to learn how to work with the windows on your
desktop. For example, if a window covers important items on
your screen, you can move the window to a new location.

You can change the size of a window displayed on your
screen by resizing it. You can maximize a window so that it
fills the entire screen, or minimize a window so that it
shrinks to the size of a button on the taskbar.

You commonly maximize a window to work in a program
and to see as much of the program window as possible. A
maximized window does not have borders. Therefore, you
cannot move or manually resize a maximized window.

Restoring a window expands it to its original size, a size that
does have borders so that you can move or manually resize
the window. 

1

1

Move a Window

1 Position the mouse pointer ( ) over the title
bar of the window you want to move.

2 Click and drag to where you want to place
the window.

The window moves to the new location.

Resize a Window

1 Position over an edge of the window you
want to resize ( changes to , , or ).

2 Click and drag until the outline of the
window displays the size you want.

8

Work with Windows
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How can I view all the information in a window?

When a window is not large enough to display all
the information it contains, scroll bars appear in the
window. To move through the information in the
window, you can drag the scroll box along a scroll
bar or click an arrow button ( ) or ( ) at the end
of a scroll bar.

How do I switch to another open window?

You click the button on the taskbar for the window
on which you want to work. The window appears in
front of all other open windows.

Why do the Minimize ( and ), Maximize ( ),
Restore ( and ), or Close ( and )
buttons appear more than once in a window?

These buttons appear for the program in which you
are working ( , , , and ), and for each
document within that program window ( , ,
and ). That is, document windows also have their
own set of window controls so that you can move,
resize, maximize, and minimize these windows within
the program window. Some programs, including
Word, open a new window instead of having
multiple documents within the same program.

Maximize a Window

1 Click the Maximize button ( ) in the window
you want to maximize.

The window fills your screen and changes
to a Restore button ( ).

To return the window to its previous size,
click .

Minimize a Window

1 Click the Minimize button ( ) in the window
you want to minimize.

• The window reduces to a button on the
taskbar.

To redisplay the window, click the taskbar
button for that window.
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Using 
Toolbars
Y ou can use toolbars to select features in a program.

Rather than opening a menu and selecting a
command, a toolbar button is often faster. A

toolbar contains buttons that you can use to select
commands and access commonly used features. Office has
an option that allows you to identify what each button does
before you select it.

When you first start an Office program, one or more
toolbars automatically appear at the top of your screen.

Office programs share similar toolbars, which makes the
programs easier to learn and use.

Although by default Office displays the Standard and
Formatting toolbars on two rows, you can change the
toolbars so that they share one row. You can then move or
resize the toolbars when necessary to access the buttons
you want.

If you are not sure what a button does, Office allows you to
display the name of a toolbar button with the ScreenTip
feature.

•

1

2

Identify a Button

1 Position over the button.

• The name of the button appears.

Activate a Button

2 Click the button.

Office performs the command you select.

10

Using Toolbars
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What if I see only one row of
buttons?

You may find the Office default
of combining toolbars into one
row confusing. If so, you can
display each toolbar in its own
row. To do so, click the Tools
menu, click Customize, and then
click the Options tab. Click the
Show Standard and Formatting
toolbars on two rows option 
( changes to ).

I do not see the name of the
button when I use the ScreenTip
feature. Why not?

You may have turned off the
ScreenTip feature. Click Tools
and then Customize. Click the
Options tab. Click the Show
ScreenTips on toolbars option
( changes to ) to activate
the feature.

Why do some buttons look a
different shade of gray?

When you click some buttons,
you turn on that feature. To
indicate that feature is on, Office
outlines the button. For example,
if you click Bold, the Bold button
appears outlined. Toolbar buttons
are toggles, which means you
can turn off Bold by clicking the
button again.

Using Buttons with Additional Options

1 Click the next to the button.

Additional options appear.

2 Click an option.

Office performs the command you select.
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Display or Hide 
a Toolbar
E ach Microsoft Office program offers several toolbars

that you can display or hide at any time. Each
toolbar contains buttons that help you quickly

perform tasks.

When you first start an Office program, one or more
toolbars automatically appear on your screen. Most
programs display the Standard toolbar, which contains
buttons to help you select common commands, such as
Save and Print.

In most programs, the Formatting toolbar also
automatically appears. The Formatting toolbar contains
buttons to help you select formatting commands, such as
Bold and Underline.

You can choose which toolbars to display based on the
tasks you perform often. For example, if you frequently
create and edit tables in Word, you can display the Tables
and Borders toolbar.

If you do not use the toolbars, you can turn them off so
that they do not take up screen space.

1 Click View.

2 Click Toolbars.

A list of toolbars appears. 

A check mark ( ) beside a toolbar name tells
you that Office is currently displaying that
toolbar.

3 Click the toolbar you want to display or hide.

The program displays or hides the selected
toolbar.

• In this example, Word displays the Drawing
toolbar.

12

Display or Hide a Toolbar
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Change Toolbar 
Placement
Y ou can move a toolbar to the top,

bottom, right, or left edge of your screen
to meet your work needs. When you

place a toolbar next to the edge of the window,
you are docking it.

You can also make the toolbar a floating palette,
placing it anywhere on-screen. With this type of
placement, you can change the size of the
toolbar.

2

1

1 Position on any blank area of the toolbar
that does not contain a button.

2 Click and drag the toolbar to where you want
to place it.

The toolbar appears in the new location.

Change Toolbar Placement
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Can I change the size of the toolbar?

Yes. To resize a floating toolbar, position over an
edge of the toolbar. Click and drag the edge of the
toolbar until it reaches the size you want.

How do I move a floating toolbar back to the top
of the screen?

To return a floating toolbar to the top or other edge
of the screen, click and drag the title bar to the top
until it is docked against that edge of the window.
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Work with the 
Task Pane
T he task pane displays various options that relate to

the current task, providing fast access to
commonly performed commands. For example, if

you select Blank Document from the New task pane, Office
creates a new blank document. The task pane appears by
default along the right edge of the program window.

You can select which features Office displays in the task
pane, and you can move back and forward between task
pane options you display. You can also close or resize the
task pane as needed.

The options in the task pane work similarly to Web links.
That is, you click the option to select that feature. When
you point to the option, Office underlines it and the mouse
pointer changes to the shape of a hand with a pointing
finger.

For some task pane options, you perform other actions
rather than selecting a link. For example, when you search
for text, you type the text to find in the text box in the task
pane. The task pane may also include drop-down lists from
which you can select options.

2

2

1

Using Task Pane Options

1 Start an Office 2003 program.

Note: See the section “Start and Exit a Program”
for details.

The New Document task pane appears.

Note: If the task pane does not appear, click View
and then click Task Pane.

2 Click an option on the task pane.

Office executes your command.

Display Other Task Panes

1 Click the next to the task pane title bar.

A list of other task panes appears.

2 Click the task pane you want to display.

Office places a next to your selection and
displays the new task pane.

14
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Do the task panes in all Office applications have
the same options?

Yes and no. The task panes share some common
options including the New document task pane,
the Clipboard, and Search. But the other available
task panes vary from application to application. For
example, Word includes task panes for working
with styles and mail merge. Because these options
do not pertain to Excel, Excel does not include
them.

If I close the task pane, how can I redisplay it?

Click the View menu and click the Task Pane
command. Office redisplays the task pane.

How can I move back and forth among different
task panes?

You can click the Forward ( ) and Back ( ) task
pane buttons to scroll among different task panes.
Note that these buttons only appear if you display
other task panes using the drop-down list.

Resize the Task Pane

1 Place on the left task pane border

( changes to .)

2 Click and drag the pane to resize.

Office resizes the pane.

Close the Task Pane

1 Click .

Office closes the task pane.
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Getting 
Help
Y ou can get help on tasks, commands, and features

in Office programs using one of several help
options.

You can use the Type a question text box in the menu bar.
With this option, you can quickly and easily type a question
and see a list of related help topics.

You can also display the Help window by clicking the Help
button in the toolbar or selecting the Help command from
the Help menu. The Help window provides several ways to

get help, including using the Answer Wizard, which is the
same as the Type a question text box, browsing through a
table of contents of help topics, or looking for a particular
topic in the index, as covered in the following questions.

In previous versions of Office, an Office Assistant appeared.
This icon prompted you for help on certain tasks and was
available for typing a question. Although the Office
Assistant no longer appears by default in Office 2003, you
can access the assistant via the Help menu.

1

4

2

• how do I make text bold

Type a Question

1 Click the Type a question text box to display
the Help text box.

2 Type a question.

3 Press Enter.

Topics relating to your question appear.

4 Click the topic of interest to display that help
page.

• The specific question appears.

16

Getting Help
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What happened to the index?

In previous versions of Office, there was a help
index you could browse to find topics of interest.
Office 2003 uses more intelligent search algorithms,
so you can find answers by typing in questions in
English, rather than guessing what the correct term
should be.

What is the purpose of the toolbar buttons in
the Help window?

You can use the toolbar buttons in the Help window
to navigate back and forward among previous
topics. You can also print a topic and dock and
undock the Help window.

What other Help commands are available?

You can click the Help menu to display a list of
other help topics, including accessing Microsoft
Office Online, getting information about the current
program version, and displaying the Office
Assistant.

What is the Office Assistant?

In previous versions of Office, the Office Assistant
was an on-screen character that appeared by
default when you started an Office application. This
has been replaced with the Type a question text
box in the menu bar.

Using the Help Dialog Box Content

1 Click the Help button ( ).

Microsoft Help appears.

2 Click Table of Contents.
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3 Click a book icon to expand a topic.

4 Click a topic to show the help pages.

Office displays the subject for you to view.

5 Click .

The Help window closes.
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